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Using this 
template  

The standard headings and tables in this template should be modified to meet the 
requirements of each Initial Assessment.  The sites may have diverse issues and 
constraints and problems and the standard template is therefore just a guide on 
typical requirements but flexibility is allowed to amend/ add headings as required 

 
 Hidden 
guidance  

The template contains various pieces of guidance covering content, use of tables 
etc.  The guidance is shown in blue text and can be turned ‘on’ to assist in the 
writing stages or ‘hidden’ for viewing or when printing the document.  You can 
switch between ‘hidden’ and ‘on’ and back to ‘hidden’ at any time. 

To show/hide the guidance click on the ¶ icon on the MS Word toolbar.  

If the hidden text does not disappear off the screen when the ¶ icon is clicked, go 
to:  Tools>Options>View Tab and uncheck the ‘Hidden text’ box.   

It is advisable to work with the hidden text turned on, as this helps to format new 
text and to avoid deleting the hidden text itself. 

 
Auto-
updating of 
contents 
page 

The contents page will update to reflect changed information in the main text and 
tables.  To update right click on the relevant area of the contents page, to highlight 
it, and select ‘Update Field” to access the update option. 

To enable these updating features to be created, the document contains specific 
text types and “fields”.  These are Headings 1, 2, 3 & 4; fields in the table labels 
and in the appendix labels.  When editing the document, take care to maintain 
these aspects. 

 
Inserting new 
headings  

To insert new headings in the main text go to: Format>Styles and Formatting to 
open the styles box. Insert the new headings, highlight it and click on the 
appropriate Heading level in the ‘Pick formatting to apply’ box.  Paragraph text 
can be inserted and formatted in a similar way. 

 
Inserting new 
tables  

Table labels should be added by Insert>Reference>Caption and selecting ‘Table’ 
from the drop down ‘Label’ box.  This will insert the Table title with the correct 
number and the caption can be typed in after the label.  Tables can then be cross 
referenced from the text by Insert>Reference>Cross Reference and selecting the 
appropriate reference type and caption from the drop down box and list. 

 
Numbering 
paragraphs  

All paragraphs should be numbered sequentially as sub-sets of the section 
number. Prompts for paragraph numbering are provided as ‘Start writing here’ 
after which pressing <return> will automatically provide the next paragraph 
number.  
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Baildon Bridge 
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1.1  Introduction and background 

1.1.1 Background 

In May 2016, CH2M were commissioned by the Environment Agency (EA), on behalf of 
Bradford Metropolitan District Council (BMDC), to undertake a package of initial assessments in 
the Yorkshire area. This report focuses on an initial assessment for Baildon Bridge, in West 
Yorkshire, which provides guidance on measures to reduce flood risk and identifies potential 
funding availability. A site visit for this Initial Assessment was undertaken on 18th of July 2016. 
This report is based on information from the site visit, previous studies and reports that are 
relevant to this Initial Assessment. 

1.1.2 Description of Location 

Baildon is a town located 5km to the north-east of Bradford. It is part of the Metropolitan District 
of the City of Bradford. The Leeds and Liverpool Canal and the River Aire run through the town. 
The area is within the River Aire Middle Catchment Flood Warning Area.  

The Baildon/Shipley area is comprised of five individual benefit areas; Aire Close, Baildon 
Bridge, Glenaire Court, Lower Holme and Masons Mill.    

Baildon Bridge cell is located on the right bank of the River Aire, starting from Ives Street at the 
upstream end to the Funopolis Play Centre on Dockfield Road. A location plan of the site is 
shown in Appendix H. 

Upstream of Baildon Bridge, the study area is amongst the 20% most deprived areas within the 
country. The study area which extends downstream of Baildon Bridge is within the 10% most 
deprived areas within the country. 

1.1.3 Description of Watercourses and Geology 

There are two watercourses in the study; the River Aire flowing west to east and Bradford Beck 
flowing south to north. 

The River Aire is a major watercourse in Yorkshire flowing from Malham in the Yorkshire Dales, 
through the urban areas of Bradford and Leeds, before joining the River Ouse at Airmyn.  The 
Aire is approximately 114km in length from its source to its confluence. 

The River Aire around Shipley and Baildon is heavily urbanised and the floodplain is 
constrained by development. There is also a large number of structures such as bridges and 
weirs in this area.  

A small watercourse, Bradford Beck, flowing south to north, joins the River Aire downstream of 
Baildon Weir which is downstream of Baildon Bridge. The beck is culverted beneath the Leeds 
and Liverpool Canal discharging into the River Aire as an open channel.   

The underlying bedrock of the Baildon area is Millstone Grit, overlain by lover coal measures. 
Ground conditions can be described as slowly permeable, seasonally wet, acid, loamy and 
clayey soils. 

1.1.4 History of Flooding 
The properties in Baildon have been flooded several times in the past.  During the December 
2015 event flooding occurred likely due high river levels in the River Aire overtopped the river 
banks and flood defences. 
 
Six historic flood events in Shipley have been identified from previous reports and studies – in 
1909, 1967, 1980, 2000 and 2008. Shipley is on the south side of the River Aire whilst Baildon 
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is on the north, opposite bank, Baildon and, it is therefore assumed that both locations were 
affected at the same time. 
 
.  
 
1.1.5 Summary of modelling analysis 

In 2008 hydraulic and hydrological modelling of the Upper River Aire was completed by JBA to 
support the development of the Flood Risk Management Strategy. For this study the River Aire 
was modelled from High Hill Weir upstream of Gargrave to Fleet Weir downstream of Leeds. 
The Upper River Aire model is a 1D hydrodynamic ISIS model containing 1922 nodes. 

This 2008 study aimed to define flood risk within this area and identify potential flood risk 
management options. This informed the Flood Risk Management Strategy for the Upper Aire 
which proposed flood risk management options for the short, medium and long-term. These 
recommendations included progressing a flood management scheme for defences at Baildon. 

Following the December 2015 flood event the  detailed modelling is being undertaken by the EA 
National Flood Modelling Team and it is still subject to confirmation. For the purpose of the 
Initial Assessment report, initial review of modelled options shown below, have been provided: 

• Three Weir Study – Re-run the Aire Model using the estimate December 2015 flows 
to investigate the removal of three weirs around Shipley and Baildon. 

• Baildon Bridge Blockage Analysis – Re-run the Aire Model using the estimated 
December 2015 flow to complete blockage analysis on Baildon Bridge. 

• Wall Scenario Downstream of Baildon Weir – Following the December 2015 event a 
riparian owner has raised the height of a flood wall on the right bank.  Various 
modelling runs have been carried out to determine the impact of the raise wall on 
flood risk to the left bank. 

1.1.6 Drivers, Constraints and Opportunities 

The Aire River falls under the Aire Catchment Flood Management Plan (CFMP) and is covered 
by sub-area 3 – Worth and Aire. The CFMP can be found here: 
https://www.gov.uk/government/uploads/system/uploads/attachment_data/file/289346/River_Air
e_Catchment_Flood_Management_Plan.pdf. The designated policy for the area at risk is ‘Policy 
Option 5: Areas of moderate to high flood risk where we can generally take further action to 
reduce flood risk. 

The following drivers, constraints and opportunities have been identified within the study area.  

Political Drivers  Summary Description 

Catchment Flood 

Management Plan 

River Aire Catchment Flood Management Plan 

Catchment Flood 

Management Policy 

5 - areas of moderate to high flood risk where we can generally take 

further action to reduce flood risk 

Economic Drivers   Summary Description 

Funding Time Constraints Must be obtained within 6 year programme of capital investment 

Social Constraints   Summary Description 

Existing Public Space Residential and commercial space in the town 

Environmental Constraints  Summary Description 

World Heritage Site There is Saltaire World Heritage Site about 600 metres to the west. 

Area in buffer zone 

Site of Special Scientific 

Interest (SSSI) 

Trench Meadows (SSSI) are located about 1600 metres to the north 

west 
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Ancient Woodland There is an Ancient Replanted Woodland - Fairbank Wood 200 metres 

to the north west; Ancient Woodlands - Midgeley Wood and Walker 

Wood are located about 900 metres to the north west; another ancient 

woodland - Old Spring Wood located 1.1 kilometres to the south west 

Contaminated Land Historical landfills (Wrose Brow Road Tip and Caststones Quarry) about 

1000 metres to the south-east from the site; Another historical landfill 

(Feriehurst Quarry) 500 metres to the north-east. 

Tree Preservation Orders According to the Bradford Council website none of the trees are 

protected in this specific area however it is recommended to check that 

area for TPOs on later stage if necessary. 

Ground Conditions Slowly permeable seasonally wet acid loamy and clayey soils 

Scheduled Monument Scheduled monument 0.5 kilometres to the south; another one 0.8 

kilometres to the north 

Listed Buildings/Structures Only one Grade II listed building (Canal Warehouse on Wharf Street) 

exists within 200m of the benefits area boundary. It is unlikely any of 

the options will have an impact on this building. 

Historical Park & Gardens Roberts Park 0.9 kilometres to the north west. 

WFD Body  River Aire (River Worth to Gill Beck) 

WFD Status  Moderate 

Refer to Appendix F for the full list of constraints that were considered. 

 

1.2 Problem and objectives 

1.2.1 Problem 

 Based on the evidence provided and local anecdotal knowledge, it is very likely that the 
flooding during the December 2015 event was predominantly from fluvial sources.  There are 15 
properties at fluvial risk within the study area. 

The current standard of protection for the study area is unknown at the time this report is written 
however investigations are ongoing and should be used in any future studies. 

During the December 2015 flood event, the River Aire overtopped due to high water levels 
caused by prolonged, heavy rainfall. In additional to the high flows two containers were swept 
into the river and became stuck under Baildon Bridge constricting the flow in that section.  

Based on all the available information, EA had estimated that the December flood event has 
1.3% – 1% annual exceedance probability (AEP). It means, that an event has between 1 in 80 
and 1 in 100 chance of occurring in any single year. 

This report will identify potential solutions to the flooding and determine if there is scope to 
determine the best cost/benefit solution to manage this flood risk. 

1.2.2 Objectives 

The primary objective of this initial assessment is to undertake a scope in the area to identify the 
flood risk issues and viable solutions for the affected properties and to identify any other 
potential flood risk management measures which are consistent with the current CFMP policy. 

The purpose of this report is to lay the groundwork and, where applicable, provide a business 
case for future more detailed appraisal. The report aims to achieve the following: 

• Confirm the need for a project; 
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• Identify the issues and Political, Environmental, Societal, Technological, Legislative 
and Economic (PESTLE) drivers and opportunities related to the need; 

• Identify the options to address the need and problem; 

• Demonstrate that viable options exist based upon the available information; 

• Provide sufficient information to allow the packaging and optimisation of packages of 
future appraisal, design and construction packages; 

• Provide sufficient information for the appraisal scope to be prepared; 

• Make an assessment on the deliverability of the project; 

• Provide a basis/starting point for discussion with communities and partner 
organisations for use in the development of potential schemes and negotiations 
regarding funding contributions. 

 

1.3 Benefits 

In this area the primary benefit associated with a reduction in flood risk would be the reduction 
in economic damages to properties. This would result in the reduction of disruption to local 
transport, businesses and other infrastructure.  

Social benefits relate primarily to a reduction in stress, health effects (including risk to life) and 
loss of memorabilia for those at risk. 

An appraisal period of 100 years is assumed, over which the current Standard of Protection of 
existing assets is expected to decrease as a result of climate change. 

Table 1.1 shows the properties at risk within the study area. 
 
Table 1.1 Number of Properties at Risk (based on current outlines) 

Property Type Flood Risk Number of 
Properties 

≥1 in 20 year (5% AEP) 
(Very Significant Risk) 

0 

<1 in 20 year (5% AEP) 
≥1 in 75 year (1.33% AEP) 
(Significant Risk) 

0 Residential  

<1 in 75 year (1.33% AEP)  
≥1 in 200 year (0.5% AEP) 
(Moderate Risk) 

0 

≥1 in 20 year (5% AEP) 
(Very Significant Risk) 

0 

<1 in 20 year (5% AEP) 
≥1 in 75 year (1.33% AEP) 
(Significant Risk) 

9 Non-Residential 

<1 in 75 year (1.33% AEP) 
≥1 in 200 year (0.5% AEP) 
(Moderate Risk) 

5 

Detail of the methodology used for assessing the benefits of each option is detailed in Appendix 
C. 

1.4 Options 
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A longlist of options has been compiled. The table below shows the large range of long list 
options considered and the reasoning for or against them being taken forward to the short list of 
options for assessment. 
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Category Long List Option Water 
Course / 
Areas 
Affected 

Description Take Forward for 
assessment? 

Reasoning / Notes / Past Study 
Reference 

Do nothing Do nothing  All operational and maintenance 
activities cease 

Yes Required to support development of 
business case and benefit cost ratios. 

Do minimum Do Minimum  Continue with current operational 
and maintenance activities.  

Yes Required to support development of 
business case and incremental b/c 
ratio. 

Non-structural 
(by EA) 

Improved flood 
warning 

 Enhanced flood warning to allow 
residents to prepare plus 
appropriate implementation of flood 
action plans 

No A flood warning system is already in 
place for Baildon.  Not funded via the 
capital programme 

Non-structural 
(by EA) 

Flood action plans  Improved direction of reactionary 
flood defence measure (fire crews, 
temporary pumps, etc.) 

No Recommended as best practice, and a 
plan must be in place to respond to a 
breach in defences. Not taken forward 
for assessment as not part of capital 
programme of works. 

Property level 
protection 

Property level 
protection 

 Protection to individual properties 
(e.g. via air brick covers, door 
guards etc.).  

Yes Passive solutions to be considered as 
an option (flood doors, automatic 
airbricks, pumps, external sealant) 

Operational 
(by Others) 

Improve 
operation/design  

 Remove or lower Baildon weir. Yes Baildon weir is located downstream of 
the site.  Lowering or removing the weir 
will lower the water levels adjacent to 
the site. 

Urban 
drainage 

Improve urban 
drainage. 

 Improve surface water drainage 
system. 

No Flooding only due to overtopping of 
defences. This would not have an 
impact on risk. 
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Category Long List Option Water 
Course / 
Areas 
Affected 

Description Take Forward for 
assessment? 

Reasoning / Notes / Past Study 
Reference 

Sewer system Improve sewer 
system 

 Improve sewer system Yes There is a YW sewer under footpath on 
right bank, upstream of Baildon Bridge, 
showed that some of the manhole 
covers were open.  This would allow 
flood water from the Aire to enter and 
take up its capacity.  So replacing these 
with a solid cover would allow the sewer 
to function without contribution from 
flood waters in the Aire (it is assumed 
that the outfall in the Aire is flapped) 

Structural Linear Defences  Repair and strengthen existing 
flood defences. 

Yes The existing defences along the river 
bank were overtopped.   Repair and 
raise existing flood defences to 
increase standard of protection.  

Structural Linear Defences  Replace the existing defences 
flood. 

Yes The existing defence may not be able to 
be increased in height, in this situation 
the entire defence will need to be 
replaced.  

Structural Conveyance  Channel deepening or widening Yes Shoal clearance should be made but it 
should be considered as an additional 
option rather that a main option.  

Structural Conveyance  Supplementary bypass channel(s, 
tunnels or floodway 

No The site in an urban location, there is 
insufficient space for a bypass due to 
consistent development within that area 

Structural Conveyance  Maintain bridge openings and clear 
them before high order events. 

Yes Baildon Bridge is a potential pinch 
point.  Clearing the bridge prior to high 
order events will reduce the risk of 
blockages.    
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Category Long List Option Water 
Course / 
Areas 
Affected 

Description Take Forward for 
assessment? 

Reasoning / Notes / Past Study 
Reference 

Structural Conveyance  Raise deck level of Baildon Bridge. Yes Baildon Bridge is a potential pinch 
point.  Raising the bridge deck will 
increase the conveyance and reduce 
water levels adjacent to the site.  
Increasing the deck level will also 
reduce the risk of blockages.   

Flood storage 
area  

Online  Use of active structures and re-
profiling to store water online. 
(River Worth). 

Yes Online flood storage area North of 
Haworth. 
The Upper Aire SFRA identified two 
potential storage areas on the River 
Worth upstream of Keighley. Use of 
these sites would reduce peak flows in 
Keighley increasing the standard of 
protection provided by the Worth 
scheme. 

Flood storage 
area  

Online  Use of active structures and re-
profiling to store water online. 
(River Aire). 

Yes As part of the Leeds FAS Phase 2 
study upstream storage is being 
considered.  The storage being 
proposed can potentially deliver further 
benefits to Bradford 

Flood storage 
area 

Offline  Gravity or pumping to offline 
storage area 

No Not considered as an option.  No 
suitable areas identified. 

Floodplain 
storage 

Washlands-type 
scheme 

 Enhance/increase natural floodplain 
attenuation with cascade of passive 
storage areas in existing floodplain 

Yes The area upstream Shipley and the 
cricket ground are possible to be 
considered as a flood storages. 
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1.4.1 Shortlisted options description 

Do Nothing 

The Do Nothing option is defined as taking no action whatsoever; under this option all 
management activities would cease, including maintenance and repair work to existing assets. 

Under this assumption, the natural deterioration of the river channel will occur, leading to an 
increase in flood risk. 

There could be some advantages of this option in the form of habitat creation due to wetting of 
dry areas and naturalisation of channel, however, this is also likely increase the risk to people 
and wildlife. 

The Do Nothing option is not to be taken forward as a viable option as it results in an 
unacceptable increase in flood risk to people and property due to failure and deterioration of 
assets and blockages to the channel, however it is required to be assessed in order to develop 
the business case. 

Do Minimum 

The Do Minimum option is defined as the minimum level of action or intervention necessary to 
maintain defence at their current level presently offered throughout the study area. Under the Do 
Minimum scenario the existing defences are maintain until the end of their design life but are not 
replaced. 

The advantage of Do Minimum is that it sustains current standard of service within the study area 
and minimises initial capital outlay. 

Option 1 – Property Level Protection 

This option considers providing Property Level Protection (PLP) measures for the properties that 
were affected by the December 2015 flood event. PLP can take the form of barriers in doorways, 
non-return valves fitted to drains, and airbrick/vent covers. Properties can also be made more 
flood resilient, using waterproof plaster, solid concrete floors or tiled floor coverings in order to 
reduce the amount of time and money needed to recover from a flood event. PLP is generally 
used as an option for properties that experience less than 500mm of flooding. 

The EA have requested the use of passive measures to maximise the effectiveness of the 
protection, ensuring the measures are installed at times of flooding. 

Property level protection prevents water entering the property but water will still be retained by 
the building structure.  Furthermore, PLP does not provide any wider environmental benefits and 
does not prevent the flooding of areas surrounding the property. 

There are currently no properties in the very significant flood risk category, therefore this option 
will not be eligible for FDGiA funding.  

This option is repeated for the other sites in Baildon, however the costings are based on the 
number of properties at risk in each individual benefit area.  Therefore the costs will be different 
for each benefit area.  

 

Option 2 – Removal Baildon Weir 

Baildon Weir is located downstream of Baildon Bridge and is owned by a 3rd party.  This option 
involves removing the weir to lower the upstream water level.  It is recommended that further 
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detailed hydraulic modelling of this option is undertaken to confirm the changes in water levels as 
the bridge upstream and confluence with the Bradford Beck downstream makes the hydraulics 
complex. 

The EA have already completed modelling for the 3 Weirs Project.  The modelling involved 
running the estimated December 2015 flows with the removal of three weirs in the River Aire; 
Hirst Weir, Saltmill Weir and Baildon Weir. The results show that the removal of Baildon Weir has 
a small impact on water levels around Baildon.  However the modelling completed to date only 
considers one flood event and the removal of the weir could be more beneficial at lower order 
events. 

This option is repeated for the other sites in Baildon, the costing for the option will be the same 
for all the benefit areas. 

 

 

Option 3 – Repair Linear Defence 

The Baildon Bridge cell is already protected by flood defences.  The existing flood defence runs 
along the river frontage.  Directly downstream of Baildon Bridge, the landowner has raised the 
level of the flood wall.  No construction details have been provided for the wall therefore it cannot 
be determined if the wall is suitable for a flood defence.   

This option looks at repairing and maintaining the existing defences upstream of Baildon Bridge 
throughout the 100 year appraisal period.  As it cannot be determined if the 3rd party walls are 
built to acceptable standards they have been excluded from this option. 

This option is repeated for the other sites in Baildon, however the costings are based on the 
length of river frontage along individual benefit areas.  Therefore the costs will be different for 
each benefit area.  

 

 

Option 4 – Improve Linear Defence 

The Baildon Bridge cell is already benefitting from flood defences.  This option proposes 
providing a uniform standard of protection of 1% (1 in 100 year) AEP and maintain the standard 
over the 100 year appraisal period. This option includes extending the existing flood wall along 
the left bank of the Bradford Beck and tying into high ground to prevent the defences being 
outflanked. 

As mentioned in option 3, a 3rd party has already raised the flood wall.  As the construction detail 
of the wall is unknown it has been assumed that a new wall will be required.   

Raised defences at Baildon were proposed as part of the long-term plan for the Upper Aire Flood 
Risk Management Strategy (2009). 

Limited water level data was available for this assessment, therefore a nominal defence height of 
1m was assumed for this option, further analysis will be required to refine the defence height if 
the option is carried forward. 

This option is repeated for the other sites in Baildon, however the costings are based on the 
length of river frontage along individual benefit areas.  Therefore the costs will be different for 
each benefit area.  

 

 

Option 5 – Raise Baildon Bridge 
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During the December 2015 flood event, Baildon Bridge became blocked by debris, reducing flows 
under the bridge and increasing upstream water levels. The bridge was also blocked by two 
shipping containers, constricting the flow in that section.  

This option proposes to raise the height of the bridge deck by 1m to increase the conveyance 
under the bridge and reduce the chance of blockages. 

This option requires hydraulic modelling to confirm its viability and effectiveness, passing more 
water beneath the bridge is likely to reduce upstream flood risk but could also increase flood risk 
downstream. The standard of protection provided by this scheme is uncertain until further 
modelling is carried out.  

Blockage scenario modelling has been completed by the EA following the December 2015 
flooding.  The modelling estimated the flows experienced during the December 2015, and tested 
it against various blockage scenarios.  The model results suggested an increase in upstream 
water levels of circa 200mm for a 75% blockage, however this is only for a single return period.   

This option is repeated for the other sites in Baildon, the costing for the option will be the same 
for all the benefit areas. 

 

 

Option 6 – Clear debris from Baildon Bridge 

The blockage analysis report at Baildon Bridge recommended to monitoring of the bridge and 
channel be undertaken when there are high flows in the River Aire.  This option is proposed to 
meet that recommendation.  The proposal is to carry out localised channel clearance directly 
upstream of the bridge to maximise the existing conveyance at the location.  

This option requires hydraulic modelling to confirm its viability and effectiveness.  The standard of 
protection provided by this scheme is uncertain until further modelling is carried out.  

This option is repeated for the other sites in Baildon, the costing for the option will be the same 
for all the benefit areas. 

 

Option 7 – Flood storage areas (River Worth) 

The 2014 Upper Aire SFRA identified a site near Lord Lane north of Haworth that could 
potentially be used as a flood storage area. This option provides a reduction in flood risk from the 
River Aire further downstream. The SFRA estimated that the use of this area could potentially 
result in a 7% reduction in peak Aire flow and a 50mm reduction in flood depths in Leeds. 

The impact of the storage area on Baildon will be a reduction in flood risk, however the 
magnitude of the impact is uncertain.  This option can be used in conjunction with other options, 
for example repairing the flood defences.   

The scheme will also provide a reduction in flood risk beyond the study area.  As a result the 
benefit-cost ratio for the option will be artificially low, being limited to the Baildon benefits.  
Therefore the economic analysis for this option is not presented in this report but the option 
should be considered in any future studies. 

Option 8 – Flood storage areas (River Aire) 

The Leeds FAS Phase 2 scheme has identified three locations that could be potentially used as 
flood storage areas; Keighley Holden Park, Marley Bridge and Rodley.  The Rodley site is 
downstream of our study area but the other two sites could potentially provide benefits for 
Baildon.  The Upper Aire FRMS has estimated a reduction of 300mm to 400mm for a 1% (1 in 
100 year) AEP event at Leeds Station.  The impact at Baildon, however, is uncertain but it is 
expected to be significant on peak water levels. 
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The scheme will also provide a reduction in flood risk beyond the study.  As a result the benefit-
cost ratio for the option will be artificially low, being limited to the Baildon Bridge benefits.  
Therefore the economic analysis for this option is not presented in this report but the option 
should be considered in any future studies. 

Option 9 – Floodplain storage 

This option considers maximising the potential floodplain storage.  There is currently one 
designated washland site identified by the EA; the sports ground and adjacent area on the left 
bank of the River Aire, opposite Masons Mill, upstream of Baildon Bridge 

The proposal is to lower the existing ground level of these washland areas to allow the areas to 
fill earlier and store a larger quantity of floodwater, therefore reducing water levels. The option is 
to reduce the existing levels of the site by 1m and create circa 38,200m3 of additional storage. 

This option requires testing in the hydraulic model to confirm its viability and effectiveness. The 
option is technically feasible, however there are risks associated with gaining land owner 
consent. The standard of protection provided by this scheme is highly uncertain until further 
modelling is carried out.  

This option is repeated for the other sites in Baildon, the costing for the option will be the same 
for all the benefit areas. 

 

 
1.4.2 Costs of options 

The costs for the options were calculated using the Environment Agency’s Project Cost Tool and 
Long Term Costing Workbook. The maintenance and operation costs relate to mechanical 
maintenance of the assets to Target Condition 3. 

It is assumed that a major replacement of assets will be required at some point during the 
appraisal period after the initial construction phase. The timing of these replacements is based on 
the EA’s Asset Deterioration Guidance (2013), and the assumptions are outlined in Appendix B.  

An appraisal period of 100 years has been used. A detailed breakdown of costs across this 
period is included in Appendix B. 

Table 1.2 shows the build-up of costs for all options. 

Table 1.2 Project costs (£k) 

Item Do 
Minimum  

Option 
1 

Option 
2 

Option  
3 

Option 
4 

Option 
5 

Option 
6 

Option 
9 

Construction 
Costs 

 
59 2,456 1,268 190 958 113 1,551 

Environment 
Agency staff 

 
9 182 94 30 151 18 115 

Consultant fees 
(appraisal) 

 
4 128 66 12 61 7 81 

Consultant fees 
(design) 

 
13 349 180 41 208 24 220 

Consultant fees 
(construction) 

 
3 145 78 11 54 6 92 

Site investigation 
& survey 

 
1 98 51 3 14 2 63 

Land purchase  0.1 12 7 0.2 1.0 0.1 8 
Optimism Bias 
(44%) 

 
39 1,482 765 126 634 75 937 
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Item Do 
Minimum  

Option 
1 

Option 
2 

Option  
3 

Option 
4 

Option 
5 

Option 
6 

Option 
9 

TOTAL  129 4,851 2,505 414 2,084 245 3,065 
Annual Operation 
and Maintenance 
Costs (including 
optimism bias) 

0.5 0.5 0.5 0.5 0.5 0.5 0.5 0.5 

 

1.5 Initial environmental assessment 

The main impacts of each option are summarised in Table 1.3: 
 
 
Table 1.3 Key environmental impacts, mitigation and opportunities 

Key positive impacts Key negative impacts Mitigation/ enhancement 
opportunity 

Option 1 
Reduced risk of flooding. Option only protects properties 

and not surrounding land. 
 

 

Option 2  
Reduced risk of flooding. 
 
Reduces future maintenance 
costs for properties at risk 

Construction work takes place in 
a watercourse. Risk of pollution 
incidents and disruption to area 
during construction. 
 
Construction work takes place in 
a watercourse. Risk of health 
hazards - possibility of 
contaminated water and water 
borne diseases. 

Best practice should be followed 
including referring to EA Pollution 
Prevention Guidance. 
 
 
 
The designer should give 
consideration to any options which 
may reduce the effect of the 
identified hazards. 

Option 3  
Reduced risk of flooding. 
 
Reduces future maintenance 
costs for properties at risk 

Construction work takes place 
alongside watercourse. Risk of 
pollution incidents and disruption 
to area during construction. 

Best practice should be followed 
including referring to EA Pollution 
Prevention Guidance. 

Option 4  
Reduced risk of flooding. 
 
Reduces future maintenance 
costs for properties at risk 

Construction work takes place 
alongside watercourse. Risk of 
pollution incidents and disruption 
to area during construction. 
 
Visual impact of raising wall 

Best practice should be followed 
including referring to EA Pollution 
Prevention Guidance. 

Option 5  
Reduced risk of flooding. 
 
Reduces future maintenance 
costs for properties at risk 

Construction work takes place in 
a watercourse. Risk of pollution 
incidents and disruption to area 
during construction. 
 
Construction work takes place in 
a watercourse. Risk of health 
hazards - possibility of 
contaminated water and water 
borne diseases. 

Best practice should be followed 
including referring to EA Pollution 
Prevention Guidance. 
 
 
 
The designer should give 
consideration to any options which 
may reduce the effect of the 
identified hazards. 

Option 6  
Reduced risk of flooding. 
 
Reduces future maintenance 
costs for properties at risk 

Construction work takes place 
alongside watercourse. Risk of 
pollution incidents and disruption 
to area during construction. 

Best practice should be followed 
including referring to EA Pollution 
Prevention Guidance. 

Option 7  
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Key positive impacts Key negative impacts Mitigation/ enhancement 
opportunity 

Reduced risk of flooding. Construction work takes place 
alongside watercourse. Risk of 
pollution incidents and disruption 
to area during construction. 

Best practice should be followed 
including referring to EA Pollution 
Prevention Guidance. 

Option 8  
Reduced risk of flooding. Construction work takes place 

alongside watercourse. Risk of 
pollution incidents and disruption 
to area during construction. 

Best practice should be followed 
including referring to EA Pollution 
Prevention Guidance. 

Option 9  
Reduced risk of flooding. Construction work takes place 

alongside watercourse. Risk of 
pollution incidents and disruption 
to area during construction. 

Best practice should be followed 
including referring to EA Pollution 
Prevention Guidance. 

 

1.6 Consultation 

The options in this appraisal were developed in consultation with the Environment Agency and 
Bradford MDC. No public consultations were held at this stage as the work is a high-level 
assessment of potential options. Stakeholder engagement will take place at subsequent stages of 
the project. 

If this project is taken forward for further appraisal it is recommended that consultation is focused 
on, but not limited to, the following: 

• Residents in the area at risk 

• Landowners and developers for the upstream storage options. 

• Riparian landowners, especially owners of riverside walls acting as informal defences 

 

1.7 Economic summary and preliminary preferred opti on 

Table 1.4 summarises the economic assessment carried out for all options. The calculations for 
PV benefits area shown in Appendix D. The options are ordered by benefit (lowest benefit first). 

The benefit values are estimates based on the methodology detailed in Appendix C. There is 
significant uncertainty in these estimates, which are based on Weighted Annual Average Data 
(WAAD) from the Multi-Coloured Manual (MCM, 2015/16). If this project progresses to further 
appraisal the benefits of these options should be more accurately assessed though hydraulic 
modelling and use of the more detailed flood depth / damage data from MCM.  

 
 
Table 1.4 Benefit-cost assessment  

 PV 
costs 
(£k) 

PV benefits  
(£k) 

Av. 
BCR 

Incr’ 
BCR 

Option for iBCR 
calc  

Comments 

Do Nothing        

Do 
Minimum 

14 
Low         24 
Mid          33 
High        41 

1.8 
2.3 
2.9 

- 
  

Option 3 747 
Low       226 
Mid        302 

0.3 
0.4 

0.3 
0.4 

Do Minimum 
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High      377 0.5 0.5 

Option 6 510 
Low       425 
Mid        567 
High      709 

0.8 
1.1 
1.4 

0.8 
1.1 
1.3 

Do Minimum 
Positive ABCR 

Option 5 2,098 
Low       425 
Mid        567 
High      709 

0.2 
0.3 
0.3 

0.1 
0.2 
0.2 

Option 3 
 

Option 1 273 
Low       531 
Mid        709 
High      886 

1.9 
2.6 
3.2 

1.9 
2.6 
3.2 

Do Minimum Highest ABCR 

Option 9 3,079 
Low       531 
Mid        709 
High      886 

0.2 
0.2 
0.3 

0.0 
0.0 
0.0 

Option 1 
 

Option 2 4,857 
Low       531 
Mid       709 
High      886 

0.1 
0.1 
0.2 

0.0 
0.0 
0.0 

Option 9 
 

Option 4 2,497 
Low       610 
Mid        814 
High   1,017 

0.2 
0.3 
0.4 

0.0 
0.0 
0.1 

Option 1 
 

 

Option 1, Property Level Protection, is the option with the highest ABCR.  The option can be 
carried forward to the next stage however it is not eligible for FDGiA funding.  The Flood and 
Coastal Resilience Partnership Funding (EA) document states that property level protection can 
be funded under OM2 for residential properties only if they are within the very significant risk 
category.  There are no residential properties in the very significant category in the benefit area 
therefore the option will need to be wholly funded by another funding stream e.g. local levy 
funding. 

Option 6, Clear debris for Baildon Bridge also has an ABCR above parity but offers a standard of 
protection less than Option 1.  However Option 6 offers community wide protection compared to 
Option1, which only protects the properties and should be taken forward.  The option is based on 
improved conveyance in the channel.  This will have a greater impact on lower order events but 
will not be as effective on the higher order events.  It is assumed that the works will be consider 
as separate discreet schemes and been classed as Capital Maintenance. 

Option 4, improve existing defences, offers the highest standard or protection (1% (1 in 100 year) 
AEP) and has an ABCR lower than option 1 and 6. 

 
1.7.1 Funding and contributions 

Preliminary estimates for Partnership Funding scores for Options 4 and 7 has been calculated as 
shown in Table 1.5.  Due to the FDGiA funding rules option 1 is not eligible for GiA funding so no 
funding calculation has been undertaken. 

Table 1.5 FDGiA Funding Calculator 
Contributions to outcome measures  Option 4 

OM1 – Economic Benefit:   

    Benefit period used for Partnership 
Funding calcs 

100 

    PV Benefits (£k) 813,854 
    PV Costs (£k) 2,483,057 
    Benefit/Cost ratio 0.3 
OM2 – No. of households moved out of any 
flood probability category to a lower category 

0 

OM2b – No. of households for which the 
probability of flooding or coastal erosion is 
reduced from the very significant or 

0 
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Other potential funding sources identified include: 

• Community Infrastructure Levy 

• Benefitting local businesses 

• Council Tax 

• Local Enterprise Partnerships 

1.7.2 Key delivery risks (economic, social and envi ronmental) 
Key delivery risk and recommendations for mitigating these risks are shown in the table below. 
 
Table 1.6 Risks and mitigation  

Risk Key Mitigation 
Insufficient 3rd party Funding available to allow 
scheme to progress 

Assess potential funding options before 
progressing scheme appraisal further. 

Risk of reducing the aesthetics of buildings 
(PLP) 

When considering resistance measures 
keep in mind their impact on aesthetics of 
buildings (PLP) 

Risks associated with gaining land owner 
consent. 

Early consultation with landowners should 
be undertaken. 

Inaccurate benefits assessment due to limited 
understanding of flood risk hence unreliable 
approach to economic damage calculations 
used for IA’s. 

A more accurate damages assessment 
based on hydraulic modelling and flood 
depth damage data should be considered 
before progressing to further appraisal. 

 

1.8 Project Scoring 

The data used in this assessment has been subjected to a RAG assessment. RAG status 
reporting is used to indicate the level of confidence in the data used in each aspect of the 
assessment, using the traffic light system. This gives a three figure score with the first number 

significant category to the moderate or low 
category 
OM2c – No. of households in the 20% most 
deprived areas moved from the very 
significant or significant flood probability 
category to the moderate or low category  

0 

Partnership Funding (PF) Score  2% 

Contributions required for a PF score of 
100% 

2,451,701 

Contributions required for a PF score of 
120% 

2,459,247 



IMNE790567-CH2-FEV-BO0-AS-C-0001 Page 19 

being the number of reds (showed as a letter R)), where there is significant uncertainty or 
challenges. The second and third numbers are the numbers of amber (A) and greens (G). The 
results are shown below: 

• A – Problem Definition:  The fluvial flooding mechanism are well understood but the 
other sources of flooding are currently unknown – AMBER  

• B – Economic Case: The benefits assessment has been based on moving properties 
from flood risk bands and weighted average annual damages – RED 

• C – Funding:  The options are likely to require external funding.  Alternative funding 
sources have been identified – AMBER  

• D – Engineering case:  Solutions taken to outline design and are tried and tested 
defence options, however may need significant change due to other flooding sources 
– RED 

• E – Permissions & Consents:  Solution are unlikely to require unusual permissions or 
consents – GREEN 

• F – Environmental sensitivities: Initial environmental assessments has been 
completed based on outline options – AMBER  

• G – Opportunities: Some potential opportunities for partnership working but minimal 
environment opportunities – AMBER  

Model. 

A 

Econ. 

B 

Funding 

C 

Eng. 

D 

Permission  

E 

Env. 

F 

RAG Opps. 

G 
2 3 2 3 1 2 231 2 

 

1.9 Further work requirements 

If the project is taken forward for further appraisal it is recommended that the following work is 
carried out: 

• Investigate the impacts of upstream storage options proposed by the Leeds Phase 2 
PAR and Upper Aire SFRA.  The findings should be used to review and update the 
economic assessment.  

• Option 2 – Further investigation and hydraulic modelling of the removal of Baildon 
weir, including lower order return periods.  The impacts of the scheme should also be 
investigated outside of the Aire Close benefit area to identify additional benefits. 

• Option 5– Further investigation and hydraulic modelling on blockage analysis at 
Baildon Bridge, including lower order return periods.  The impacts of the scheme 
should also be investigated outside of the Aire Close benefit area to identify additional 
benefits. 

• Option 9 – upstream storage will have benefits outside of the study area.  Hydraulic 
modelling of this option should be carried out to assess if the changes in downstream 
water level potentially provide additional benefits. 
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1.10 Conclusions and Recommendation 

The conclusions and recommendations made in this section are based on the limited data 
available at the time.  It is strongly recommended that further investigation into all sources of 
flooding are undertaken  

Based on the evidence provided it is believed main risk of flooding within Shipley/Baildon is fluvial 
from the overtopping of river banks. The existing fluvial flood risk is moderate to high.  There was 
significant flooding in the area during Boxing Day 2015 from the River Aire.  

Option 1, property level protection is the highest scoring Do Something option, however due the 
funding rules is unable to gain any FDGiA funding.  There is uncertainty over the effectiveness of 
a PLP scheme, further investigation into suitability of the properties to be fitted with property 
protection measures. 

Option 6, clearance of debris from Baildon Bridge is the next highest scoring option, and offers 
community wide protection, unlike Option1.  However this option is unable to gain any FDGiA 
funding, as it is maintenance of an existing asset. It is recommended that inspections and 
maintenance programme of Baildon Bridge are reviewed to reflect the importance of the 
structure.  

Option 4, improve existing defences provides the highest standard of protection.  The option is 
eligible for 2% of the costs being funded by FDGiA funding. 

It is recommended that the flood storage options are considered further in a wider strategic 
assessment as they could benefit a large areas on the Upper Aire. 

The Baildon/Shipley area is comprised of five individual benefit areas; Aire Close, Baildon Bridge, 
Glenaire Court, Lower Holme and Masons Mill.   It is recognised that there is potential to manage 
flows upstream and provide further benefits to all areas.  Potential storage sites have been 
identified between Hirst Mill and Baildon Bridge, see figure 2 in Appendix H.  It is recommended 
that further hydraulic modelling be undertaken to investigate the impact of these storage areas on 
water levels within the Baildon/Shipley area and further downstream.   

Based on the limited information we have available, we advise the Do Minimum scenario, to be 
the most appropriate. However, we recommend further investigation to be undertaken to 
determine all flood risk sources and how they can be managed.  
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Appendices 


